Visual Charon Manual

Introduction

The Charon Visual Tool is used to create agents and modes that conform to the Charon language.  The elements of a Charon system are created visually and can then be converted into a textual representation for use in the Charon simulation tool.

Description of the Interface

The graphical user interface is divided into 4 main components.

(1) The canvas, located on the right side of the main window, is the largest component and is where agents, modes, sub-agents, sub-modes, control points, transitions, I/O ports, and renamings are visualized.

(2) The tools component is located in the upper left corner of the main window.  It contains tool icons for control points, transitions, and renamings.  A discussion of how to use the tool icons will follow.

(3) The Project component is located in the central left position of the main window.  It contains a tree listing of all of the agents and modes in the current project.  Agents are identified by a red rectangular icon preceding its name.  Modes are identified by a blue rounded rectangular icon preceding its name.

(4) The Definition component is located in the lower left corner of the main window.  It contains three tabs with the labels: Params, Variables, and Constraints.  This component is used to modify the definition of an agent or mode.

Creating a Project

When the Visual Tool is started an empty project entitled “New Project” is initially opened.  In the Project window underneath the Current Project tree you will see the name of the new project.  The name of the project will be used when you load other projects (referred to as packages) and use agents and modes from the loaded packages.  To change the name of the project, right click on the project name and select Rename from the popup menu.  Enter a new name for the project and select Set.

Saving a Project
To save a project, select either Save Project or Save Project As  from the File menu.  The project is saved as a single xml file that conforms to the supplied charon.dtd document type definition file.

Opening a Project

To open a project, select Open Project from the File menu.  Note: The supplied charon.dtd file must be located in the same directory as the xml project file you are opening.

Producing Charon Source Code
After a system is created using the visual tool, it can be transformed into its equivalent Charon textural description, i.e. a .cn file.  All agents and modes will appear in a single Charon source file.  To produce this file, select Write Source from the Charon menu.  Note that you should not have any orphaned control points or I/O ports when you write the Charon source file.  This will produce unknown behavior.  For more information on orphaned control points and I/O ports, see the sections on Control Points and I/O Ports.

Creating an Agent

An agent can be created and added to the current project by selecting New Agent Definition from the Model menu.  Enter a name for the new agent and press the Set button.  You will now see that the Canvas contains a large white square, which represents the newly created agent.  The agent’s name can be found on the selected tab at the bottom of the Canvas.  You will also now see the new agent’s name listed under the project name in the Project window.  Select Close Window from the View menu in order to close the new agent’s canvas.  To view the canvas again, double click the agent’s name in the Project window.  If you right click on the agent’s name in the Project window, you will be presented with the options to Edit the agent’s name, or Delete the agent from the project.

Creating a Mode

A mode can be created and added to the current project by selecting New Mode Definition from the Model menu.  Enter a name for the new mode and press the Set button.  You will now see that the Canvas contains a large white rounded rectangle, which represents the newly created mode.  The mode’s name can be found on the selected tab at the bottom of the Canvas.  You will also now see the new mode’s name listed under the project name in the Project window.  Select Close Window from the View menu in order to close the new mode’s canvas.  To view the canvas again, double click the mode’s name in the Project window.  If you right click on the mode’s name in the Project window, you will be presented with the options to Edit the mode’s name, or Delete the mode from the project.

Adding and Editing Parameters to an Agent or Mode’s Definition

Open the agent or mode by double clicking on its name in the Project window.  Select the Params tab in the Definition window.  To add a parameter, select the add button.  You will be presented with a dialog to enter the parameter’s type (or select it from the list) and enter the parameter’s name.  Once Apply is pressed, the new parameter will be listed in the Params window.  To edit a parameter, double click its entry in the list and make the appropriate changes in the dialog that is opened.  To delete a parameter, select it from the list and press the delete button.

Adding and Editing Variables to an Agent or Mode’s Definition

Open the agent or mode by double clicking on its name in the Project window.  Select the Variables tab in the Definition window.  To add a variable, select the add button.  You will be presented with a dialog to select the variable’s interface and update specifier, enter the variable’s type (or select it from the list) and enter the variable’s name.  An initial value can also be entered, but only agents make use of a variable’s initial value.  Once Apply is pressed, the new variable will be listed in the Variables window.  To edit a variable, double click its entry in the list and make the appropriate changes in the dialog that is opened.  To delete a variable, select it from the list and press the delete button.

Adding and Editing Constraints to a Mode’s Definition

Open the mode by double clicking on its name in the Project window.  Select the Constraints tab in the Definition window.  To add a constraint, select the add button.  (Note that the add button cannot be pressed if an agent is the currently active canvas since constraints cannot be added to agents.)  You will be presented with a dialog to select the constraint’s type, enter the constraint’s name, and enter the actual constraint.  The constraint should be entered as it would be in the textual Charon language.  For example, the constraint box might contain “d(timer) == 1” if the constraint’s type is Differential.  Once Apply is pressed, the new constraint will be listed in the Constraints window.  To edit a constraint, double click its entry in the list and make the appropriate changes in the dialog that is opened.  To delete a constraint, select it from the list and press the delete button.

Adding/Deleting/Editing/Resizing a Sub-Mode

Open the mode or agent definition to which you wish to add a sub-mode.  Click and drag the sub-mode’s name from the list of modes in the project window to the canvas.  When you release the mouse button, a dialog appears where you must give the sub-mode a name and its arguments.  After a sub-mode is created, a rounded box appears on the canvas, which represents the sub-mode.  Select the sub-mode by left clicking on its box.  Reposition the sub-mode within the mode or agent by clicking and dragging it.  Edit the sub-mode by right clicking on it and choosing Edit from the popup menu.  Delete the sub-mode by right clicking on it and choosing Delete from the popup menu.  The sub-mode can also be deleted by selecting it and then pressing the delete key.  To resize a sub-mode, select it and press the plus key to enlarge it or the minus key to shrink it.

Adding/Deleting/Editing/Resizing a Sub-Agent
Sub-agents are created, deleted, edited, and resized exactly the same as sub-modes.  The only difference is the shape of the box on the canvas.  A sub-agent uses a normal rectangle, whereas a sub-mode uses a rectangle with rounded corners.  For a reference to creating, deleting, editing and resizing sub-agents, see the above section on sub-modes.

Control Points

Non-default control points are added to a mode by dragging either the entry point or exit point tool from the tools window and dropping it near the edge of a mode definition on the canvas.  Upon a successful drop, a dialog prompts the user for a name for the new control point.  Entry points are represented by a green dot.  Exit points are represented by a purple dot.  When a control point is added to a mode definition, all current instances of that mode will be updated automatically with the new control point.  To delete a control point, select it and press delete.  If auto remove orphans is checked in the Model menu, then when a control point is deleted from a mode definition, it is automatically deleted from all instances of the mode definition.  As a result, all transitions utilizing the deleted control point will also be removed.  If auto remove orphans is NOT checked in the Model menu, then all instances of the deleted control point will be marked as an orphan, and colored white with a red border.  To delete an orphaned control point, select it and press delete.  (Note: the reason for using orphaned control points is to see what the effects of deleting a control point are.  In a future version of the visual tool, it may be possible to undo certain operations.)

Default Control Points

Default control points are always present when a mode is created.  For information on using default control points, see the section on Transitions.

Transitions

To create a transition from a non-default control point to a non-default control point, drag the transition tool from the tools window and drop it on the starting control point.  A transition is now started and line originating from the control point follows the cursor is moved.  Click on the ending control point to finish the transition.  A dialog appears to input the transition’s name, guard and actions.  The guard and actions should be entered using the Charon textual syntax.  Once a transition is created, it can be selected by clicking on it.  Double clicking on the transition will bring up the edit transition dialog.  To delete a transition, select it and press delete.

Transitions to and from Default Control Points

A transition that uses a default control point behaves the same way as transitions described above except in the way it is created.  To create a transition that starts from a default control point located on a mode definition (the large, encompassing, rounded box on the canvas), drag the transition tool from the tools window to an empty area on the edge of the rounded box instead of to a specific control point.  To create a transition that starts from a default control point located on an instance of a mode (one of the small, rounded boxes on the canvas), drag the transition tool from the tools window to an empty area near the edge of and within the smaller rounded box instead of to a specific control point.  To finish a transition that ends at a default control point located on a mode definition, click on an empty area on the edge of the rounded box instead of on a specific control point.  To finish a transition that ends at a default control point located on an instance of a mode, click on an empty area near the edge of and within the smaller rounded box instead of on a specific control point.

Input/Output Ports (I/O Ports)
To create an I/O port in an agent definition, drag the variable associated with the I/O port from the Variables tab in the Definition window to the edge of the large rectangle in the canvas, representing the agent definition.  (Note: private variables cannot be used as an I/O port.)  Output ports (write variables) are identified by a dark blue-green square dot on the edge of an agent or sub-agent.  Input ports (read variables) are identified by a light blue-green square dot on the edge of an agent or sub-agent.  When an I/O port is added to an agent definition, all current instances of that agent will be updated automatically with the new I/O port.  To delete an I/O port, select it and press delete.  If auto remove orphans is checked in the Model menu, then when an I/O port is deleted from an agent definition, it is automatically deleted from all instances of the agent definition.  As a result, all renamings utilizing the deleted I/O port will also be removed.  If auto remove orphans is NOT checked in the Model menu, then all instances of the deleted I/O port will be marked as an orphan, and colored white with a red border.  To delete an orphaned I/O port, select it and press delete.  (Note: the reason for using orphaned I/O ports is to see what the effects of deleting an I/O port are.  In a future version of the visual tool, it may be possible to undo certain operations.)

Renamings

To create a renaming between I/O ports on two sub-agents, drag the renaming tool from the tools window to one of the I/O ports on a sub-agent.  Once the mouse button is released, an arrow appears originating from the I/O port and follows the cursor.  To finish the renaming, click on the second I/O port on another sub-agent.  Upon successful completion, a dialog appears where you must choose what the two variables should be renamed as.  To edit the renaming, double click on the orange arrow in the canvas.  To create a renaming between a sub-agent and an agent definition, start the renaming from an I/O port on either the sub-agent or the agent definition and finish it on an I/O port on the other.  A dialog will not appear because this type of renaming simply renames the variable on the sub-agent as the variable on the agent definition.

